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Welcome to our 53rd edition of the PhotographyBB Magazine. 
although the weather may have you thinking otherwise 
(especially if you live in Vancouver), it’s summertime and 
that means many of you will have more photo opportunities. 
there are the canada Day and independence Day celebrations 
complete with fireworks, many of you will be travelling on 
vacation, and the longer evenings allow us more time to get out 
and do what we love - making pictures.

i’d like to talk a bit about making time. i’ve been noticing a trend 
lately. While there are an increasing number of photography 
enthusiasts, many active photographers seem to be less involved 
with their craft. We take photos for the pure enjoyment and 
artistic relief gained through releasing our creativity. the problem 
is, we’re all so busy these days that making time for enjoyment 

has almost reached the point of being stigmatized as a luxury. 

Being someone who greatly feels the effects of “not having enough time”, i can say this with 
absolute certainty - We feel that we don’t have enough time, because quite frankly, we suck at time 
management! Plain and simple. 

in a recent photo assignment that we posted, one participant involved his son in the process. he 
wasn’t happy with the resulting assignment photo, but the experience of involving his son with his 
photography was both fun and memorable. that’s what photography is all about. Making time to 
enjoy the craft, and making memories while doing it.

We all find pleasure in creating photos. We’ve just forgotten the importance of doing it as it relates 
to our own mental health and personal development. Make time for reading the photography 
books you enjoy. set aside 15-minutes every other night if that’s what it takes.  also, this month i 
challenge you to try something new with your photography that you’ve always wanted to do. We all 
have something we’ve been wanting to photograph. Make the time. Make it happen.

My thanks to all of our readers who so generously find the time to download our magazine each 
month. a big thanks also goes out to the contributing team for their efforts in building a stronger, 
more creative photographic community. enjoy Volume #53!

Dave seeram 
editor and Publisher

PhotograPhyBB online Magazine Vol. FiFty-three
From the editor’s Desk

Make time for the things that matter...
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DaVe Seeram is the editor of the Photog-
raphyBB online Website, PhotographyBB 
Forums, and editor/Publisher of the Pho-
tographyBB online Magazine. Dave is also 
a digital photography and Photoshop en-
thusiast. 
PhotographyBB | twitter | Facebook

eVa POLaK is one of new Zealand’s leading 
fine art photographers. With her specialty 
in impressionist photography, eva is 
the author of two books and provides 
workshops on teaching creativity in fine 
art photography. 
Website | Books 

JOn ayreS is a digital photographer from the 
united states, now living in Moscow. he 
enjoys photography, writing, and history. 
Jon has been involved in writing, digital art 
and photography for over 30 years and is a 
published photographer and author.
Blog | Flickr | redBubble

HeatHer BaSHOw is a tech junkie from 
Kingston, ontario, and is obsessed 
with Dslr photography and software 
technique.  never without her camera by 
her side, she embraces all genres… but no 
rules.
Website | Books 

BiLL mcCarrOLL is a passionate nikon pho-
tographer, web developer, and a technol-
ogy and camera gear addict pursuing his 
love for photography while supporting 
community activities as a volunteer. 
Blog | twitter | Flickr

JaSOn anDerSOn is an active photogra-
pher, shooting primarily with canon 
gear. his philosophy about photogra-
phy is learning through the sharing of 
knowledge, and enjoys both the art 
of photography as well as his written 
pursuits. 
Blog | twitter | Podcast

CHriS StyLeS (aka “nobby”) is our forum 
moderator. two years off retirement & 
proud grandfather to 2 boys, 4 girls, his 
interest in photography stretches back 
over 40 years, and really took off with a 
renewed passion since buying one of the 
first hewlett Packard’s digital cameras. 
chris now shoots with a nikon D700.

GreG mCCOmSey is our forum moderator. 
Born and raised in Pennsylvania, he now 
resides in ohio after serving 20 years in 
the us air Force.  greg enjoys photogra-
phy as a hobby and the continuing learn-
ing process that goes along with it. 
gallery | Flickr

ConneCt with the writers oF PhotograPhyBB
the Contributing authors

In this edition...

http://www.photographybb.com
http://www.twitter.com/photographybb
http://www.facebook.com/PhotographyBB
http://www.evapolak.com
http://www.evapolak.com/books.html
http://jondayres.blogspot.com
http://www.flickr.com/photos/jonayres
http://www.redbubble.com/people/bossman
http://www.deerhaven-photography.com/
http://www.blurb.com/user/store/ballybay
http://billmccarroll.com
http://twitter.com/BillMcCarroll
http://www.flickr.com/photos/billmccarroll/
http://www.canonblogger.com
http://twitter.com/cbjason
http://www.canonblogger.com/the-podcast/
http://gregmcc.smugmug.com/
http://www.flickr.com/photos/35696215@N04/
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newS & UPDateS

DIY LegaL KIt
Do you share your photography online? On 
your blog? Do you sell your images to clients 
or friends? Submit them to magazines or 
newspapers for publication? Even without 
compensation, photographers require proper 
legal documentation to support the use of their 
images. Enter the Do-It-Yourself Legal Kit from 
canonBlogger.

Written with the assistance of an experienced 
copyright attorney, the DIY Legal Kit includes a 
standard event contract, licensing agreement, 
adult model release, and minor model release, 
all ready for inserting your own custom logo 
and/or business name. The “Prequel” explains 
the ‘why’ and ‘when’ to use each form. Everything from Copyright, Right to Privacy, Fair Use and more 
is covered in 12 easy-reading pages.  The subject matter is broken up with questions, answers and 
short narratives surrounding each concept and is designed specifically with the photographer in mind. 
PhotographyBB readers get a special discount with code: BBDIY

Now that’s DROBO-licious!
Be honest - When is the last time you thought 
of a storage device as sexy? Never. Until 
now. Drobo has just announced two hot 
new products: The Drobo 5D - perfect 
for photographers who need the most 
robust backup security for their images. 
With Thunderbolt and USB 3.0 support, 
coupled with a new SSD Accelerator Bay, capacity and 
performance will see a noticeable boost. In addition, 
on-the-go photographers will be drooling over Drobo’s 
revolutionary new device - the Drobo Mini. Sporting support 
for four 2.5” drives and SSD, the new Drobo Mini packs Thunderbolt 
performance and RAID protection in a compact package. For detailed 
specs and several gorgeous images of these new devices - visit this link!

an attorney costs hundreds of dollars... the DIY Kit is only $27!

Buy it Now!   $27

http://www.photographybb.com/canonblogger
http://www.photographybb.com/site-news/5d-drobo-news/
http://www.photographybb.com/canonblogger
http://www.photographybb.com/canonblogger
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UP CLOSe
A Guide to MAcro And close up 

photoGrAphy

It’s true that when we hear “macro photography”, our mind instantly 
travels to images of bugs and close-ups of flowers, but there’s a 
subtle beauty to be found in everyday things that we most often 
overlook. Subjects that we normally fail to investigate contain a 
myriad of imagery just waiting to be captured. The rim of a coffee 
mug, a cork from a wine bottle, the inner workings of a clock – the 
possibilities are limitless.

uP close: a guide to Macro and close up Photography by 
Andrew S. Gibson, really dives into macro photography in both fun 
and exciting ways. At 88 page-spreads, this PDF eBook is a great 
value for anybody interested in learning and improving their close 
up photography techniques.

get it Now! (pdF Format)

Learn all about: equipment for close-up photography, lens 
dynamics, focal lengths vs. focal distances, depth of field for 
macro photography, close up lighting, and much more...

http://www.photographybb.com/craftandvision/up-close/
http://www.photographybb.com/craftandvision/up-close/
http://www.photographybb.com/craftandvision/up-close/
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i recently came to the realization that for the 
first time in years, both of my film cameras 
have rolls of film in them that are several 

months old. To be more precise, I shot about 
120 frames of film and Lord only knows how 
many thousands of digital photos during a trip 
this past December. I dropped in new rolls of 
film, and since then, not a single frame of film 
has been shot.
 
I still use my digital cameras; this is not about 
having issues with taking photos (see my 
editorial in PhotographyBB Magazine, Vol.51). 
It’s just that I am less film and more digital 
than ever before. The reason is that (for me at 
least) film is now just too much trouble. Oh 
my! I remember reading this about 6, 7, 8, 9, 
and even 10 years ago and thinking that my 
trusty old Nikon film SLR would never be too 
much trouble to use, so what is going on?
 
I am (or rather have been) a great fan of film. I 
used to love doing slides as Kodachrome gave 
me those deep and highly saturated results 
that most people seem to love quite easily. But 
with the environmental issues connected with 
the chemicals, the lowering demand, and the 
way that Kodak has been going financially this 
past decade, it died.
 
Some of the less popular film formats 
have already gone, and recently the last 
manufacturer of APS format film (Fuji again) 
announced that they were stopping the 
manufacture of it. Actually I am not terribly 
unhappy about that. APS film was a mistake 
from the very start. The idea was good, but 

consumers wanted something that would 
not cost more, or having to buy yet another 
camera format. So while it has limped along 
for years, sales have been almost zero and now 
sales of film are so low, it is slowly dying.
 
About a year ago, my local camera dealer 
stopped developing film in the store. When 
speaking with the manager about why, he 
said that it cost them too much to clean and 
maintain the mini-lab. They were processing 
about 10-12 rolls a week and unless they 
were able to do that many each day, it would 
cost more money to keep it going so in the 
end, it died. 

They still sell film, but only two or three types 
of color print film and one type of B&W stock. 
The chemical and photo paper section that 
they used to fill a wall with is now down to 
just two end caps amid rows of displays that 
include digital photo frames, memory sticks 
and “How to shoot with your digital camera” 
DVD’s. Along with demand, it also seems like 
dealer enthusiasm for film has also died.
 
It’s actually getting quite difficult to find a 
one-hour film processing photo lab anymore. 
At least, that’s the case in my part of the world. 
I can drop my rolls of film in an envelope 
and wait a week for it to come back from a 
lab somewhere in another state. In April this 
year, Fujifilm saw some significant price rise 
announcements and now it is getting really 
hard to find any in really fresh condition. I 
wonder what that tells us… Are the days of 
film coming to an end?

On Film: are we reaching the end?
an editorial by Brian Richman
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i love to shoot black and white photographs.  
In fact, lately it’s become my preferred 
style for daily shooting.  Black and white 

photographs strip out distracting color 
elements from the composition, leaving 
only the tones of blacks and whites to focus 
the viewer on the key parts of an image.  
Naturally, not all shots are best suited to 
monochrome treatment.  That fact in itself will 

start to drive you towards subjects that best 
fit the result as you envision a final image with 
this treatment.

There are a many ways to achieve a 
monochrome image.  This article will take you 
through the workflow I use to produce mine.  
As I said, there are many ways to get good 
results, and mine is just one way of doing it.  

by Bill McCarroll

building creATiviTy

How to make gReat

imagesBlack & White
A Workflow Walkthrough
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The post-processing tools in my workflow 
are fairly simple.  I use adobe Photoshop 
lightroom 4® and nik’s silver efex Pro®.  You 
can download both of these programs in 
trial mode and use them for a few weeks to 
follow these steps and see if they give you 
the black & white results you’re looking for.  
I’ll tell you right up front that Silver Efex Pro 
gives me much richer results in my final black 
and white images, so when looking for the 
best results, I’ll go to that.  If I’m looking for 
something quick (but not entirely perfect), I’ll 
go with Lightroom adjustments.  Experiment 
for yourself and see which suits you best.  
One thing to note is that Silver Efex Pro works 
just as well with apple’s aperture® if that’s 
your choice for post-processing and your 
photo library.

The first things to consider with black 
and white photography are your camera 
settings.  I always shoot RAW images in my 
camera.  Shooting RAW will always provide 
you with a digital negative that captures all 
the data in every frame you shoot.  It gives you 
the most flexibility to adjust your images in 
post-processing.  It also retains all of the data, 
including the results from a color image.  I use 
the RAW image to finish a black and white 
photograph in Silver Efex Pro.

In addition to generating a RAW image, I 
set my camera to also give me a JPEG file.  I 
generally process the JPEG file in Lightroom 
to gently tweak it to a final black and white 
image that I like. The JPEG file is processed 
in-camera so most of the image information 
is “baked” into the file and is not easily 
adjustable. You can tweak image settings to 
some degree, just not as much as in the RAW 
file.  The downside to this workflow is that with 
two image files per shot (RAW + JPEG), you’ll 
be using extra memory in your camera’s card 

and on your computer when you download 
the files to Lightroom. 

Following my workflow: Begin by setting 
your camera to generate a RAW file plus a 
JPEG fine image.  After that, choose black and 
white (or monochrome) via your camera’s 
color settings menu. There will be other 
options for color including things like standard 
/ normal, vivid, etc.  Now you’ll get two images 
from your camera; one with all the data from 
your image including all the color you saw 
when you took it, plus you’ll get a second 
image in black and white.  

One point that I always try to follow even 
when I’m looking for a black and white image: 
Make sure your white balance is correct for 
the conditions you’re shooting in.  Remember, 
you’re getting a RAW image in color and you’ll 
want to get that color true to the conditions 
in which you shot it. It will also produce subtle 
tonal differences in the black and white JPEG 
that the camera generates. I always carry a 
Whibal card with me to make sure my white 
balance settings are correct.  Making the 
effort to ensure your color images are true 
to life will have a significant impact on your 
photography, whether you’re shooting in color 
or black and white.  I use mine all the time, 
religiously, and it makes a big difference in the 
results. Check out this article from thorsten 
overgaard on white balance settings and see 
if it doesn’t convince you.

Lightroom Workflow (JPegs)
Before downloading your images to the 

computer, go into Lightroom’s Preferences.  In 
Preferences, go to File Handling and uncheck 
Embed Original File.  This will keep your 
RAW and JPEG files separate so that you can 
view both of them in your library.

http://www.adobe.com/go/trylightroom/
http://www.adobe.com/go/trylightroom/
http://www.niksoftware.com
http://www.apple.com/aperture/
http://www.overgaard.dk/WhiteBal_greycard_manual_white_balance.html
http://www.overgaard.dk/WhiteBal_greycard_manual_white_balance.html
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After shooting for the day, I download my images to the computer using a card reader.  I 
don’t download directly from the camera.  I find that my images transfer more quickly through 
a card reader, and I just prefer not to use my expensive camera for something I can do without - 
exposing it to the rigor of a download session.

Once your photos are displaying in the library, you’ll have two images side by side for each 
shot you took (see example below).  One will be the RAW file in full color and the other by its side 
will be the black and white JPEG file.  Now you can compare the color to the black and white.  

Remember, the color file is the RAW file and the black and white image is the JPEG file; both 
straight out of the camera. This is how I judge whether the black and white file even works for 
me.  If it’s close the final result I’m looking for, I’ll make a choice to do one of two things:  Either 
I’m going to tweak the JPEG file in Lightroom or I’m inspired enough to make the best black and 
white image I can through the flexibility and power of Silver Efex Pro.  

We’ll start by exploring the simple workflow that I 
use for tweaking my black and white JPEG images in 
Lightroom.  I begin with the JPEG version of the image, 
and head to the Develop Module.  Once there, the right 
panel in Lightroom offers adjustment tools in the right 
side panel.  I generally only tweak my JPEG files using the 
Basic adjustments panel and the Detail panel.

The Basic adjustments panel offers several settings.  
Keep in mind that this JPEG file has already been 
processed in your.  So, adjustments are possible here, 
but you need to make sure to be gentle with the 
tweaks. JPEG files don’t offer the same flexibility for 
liberal use with these sliders, and you may start to see 
weird, undesirable effects in your photograph if you 
push them too far.  
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I start with the Exposure and Contrast sliders first.  I want 
my photograph to render exposure properly, and if I make 
adjustments to the exposure it can wash out the contrast, or 
I’ll lose detail in the shadows.  Adjusting the Contrast, Blacks, 
or using the shadow slider can compensate for this.  Keep 
in mind, there is no set formula here.  You just need to work 
these until you are happy with the results.  I may also push 
Clarity to the right a bit; I like this slider when it pulls out 
additional detail.  Just remember to use these sliders with 
care and do make huge adjustments in any of them for the 
best results when working with JPEGs.  

Once I have the image looking the way I like, I’ll move 
to the Detail panel to sharpen the image.  I’ll generally pull 
Sharpening to somewhere between 20-40, but again, every 
image is unique.  It’s important to use the loupe to make 
sure you’re not seeing strange halo effects around the high 
contrast edges of detail in your image.  If you do, pull back 
the Sharpening slider until they disappear.  

Lastly, I’ll look at a dark section of my image and make 
a noise reduction adjustment.  With black and white, some 
noise may work for you depending on the look you would 
like to create. That’s my simple workflow in Lightroom!

For images that I would like to take further, and have maximum flexibility during the post-
processing, I will use Silver Efex Pro. Here is a walkthrough of my process.

Silver efex Pro (RaW)
Silver Efex Pro is a Lightroom® plugin. If you have Photoshop® or Aperture® installed, it will 

offer to add it for those programs too.  The focus of this article will be on how it works with 
Lightroom.

Silver Efex Pro2 offers enormous power and flexibility. Even with all of its features and 
capabilities, it’s very rare that I spend more than five minutes in Silver Efex Pro to get the 
results I am looking for.  

First, highlight your image by choosing Image > Edit in > silver Efex Pro 2.  From there 
your image will render in a neutral black and white.  Many times this gives me a fine start to 
my post-processing workflow.  
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The left panel offers your image with several great presets 
built into the software.  You can also create and save your 
own presets here for future use.  I will generally go through 
all of these to see which inspire me.  There is always one that 
comes close to what I’m looking to achieve.  

Generally I tweak my shots using the right side panel 
along with the global adjustments offered by Silver Efex Pro.  

While these are global adjustments that affect various 
attributes of the image, they only affect the photograph in 
selective ways.  For example: With Brightness, there is a global 
adjustment to the overall brightness of the image. However, 
the submenus for Brightness offer controls that allow you 
to be much more selective as to which areas of your image 
will be impacted.  This same flexibility is also offered by 
adjustments to Contrast and Structure.  Collectively these 
very versatile sliders offer infinite variations on how you’ll be 
able to get to the final image you envision.  

There is one extremely useful tool common to Nik’s software, which is their U-Point 
Technology.  This allows you to choose select areas of your image and make focused 
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adjustments to a select group of relative 
pixels within an area that you define.  Now, 
instead of global adjustments affecting 
the entire image, you’re able to adjust a 
very select group of pixels instead.  This is 
what makes Silver Efex Pro 2 a great tool 
in achieving your desired black and white 
results.

I may also use the selective color 
filters to really pull out some of the tones.  
Additionally, there are film types to give 
your black and white photos the look of 
manufacturer’s film at various ISO’s.  These 
film looks are amazingly good!

Once you’ve made all your tweaks you can 
save the result.  This will render the file back 
into Lightroom in the file format defined in the 
Silver Efex Pro 2 Preferences panel.  

I hope this inspires you to try “shooting” 
black and white photography. By shooting 
with the intention of converting to black 
and white, you will learn to see subjects and 
lighting in ways that will greatly improve 
your photography. With a few simple post-
processing steps such as those we’ve just 
looked at, you can easily create memorable 
and evocative black and white images to be 
proud of. Have fun exploring!

This article and images contained are Copyright © and courtesy of Bill McCarroll. Please contact the author directly with any questions.
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light is the single most important factor 
in all of photography. It’s the effect of 
light and shade that provides images 

with realism and expression. As impressionist 
photographers, we don’t necessarily 
photograph what we see. We attempt to 
capture the light and its effect on the subject 
matter. The work done in a painterly and 
poetic manner enables the viewer to become 
engaged in the interpretation of the subject 
and mood. 

Light is not difficult to understand, but it 
does require a conscious effort to observe 
its effects. We have many terms to describe 
a light source: hard light, medium light, soft 
light, sidelight, backlight, warm light, low-
key, high-key, etc. Basically, these descriptive 
terms are referring to one or more of the four 
basic characteristics of light: colour, contrast, 
direction, and intensity. When you understand 
the dynamics of these four qualities and their 
impact on how we perceive form, colour, 

How the Four Main Characteristics of Light Affect Your Photographs

by eva polak

Light
    & Mood
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space, and atmosphere, there is no limit to 
your ability to use them creatively.

The way an object is lit will depend on 
whether it is a bright or overcast day. On cloudy 
days, highlights and shadows will be soft and 
edges of these shadows will be blurry. On a 
sunny day, the highlights will be more intense 
and shadows sharper.  Strong light adds depth 
and drama to a photograph. Soft light lets you 
capture subjects in a gentle, quiet moment.

The direction of the light source has a 
profound effect on our perception of it and 
on how an object in a scene will appear. For 
example, front lighting doesn’t reveal form. 
It makes things look flat, but it is very good 
when it comes to showing off colour. Back 
lighting can often look very atmospheric and 
dramatic; it creates a “rim light” that helps 
define edges. Side lighting is wonderful for 
highlighting form and texture. Top lighting 
can lend an air of mystery.

You will notice that the quality of (natural) 
light changes with weather, and also from 
season to season. Compare the cool light 
of winter’s day with the warm light of a hot 
summer afternoon. 

Colour is the most subtle characteristic of 
light, but also its most evocative. The colour 
of light changes throughout the day from the 
first pinkish spray at dawn, through the clear 
white light of midday, to the golden moments 
of the late afternoon.

Consider the feelings you experience at 
certain times of day, and that may help you 
choose the best lighting situation for the 
mood you want to convey in your images.
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Light also has a dramatic effect on our 
moods and feelings. We feel cheerful and 
happy on a bright, sunny day and perhaps 
more contemplative or even a bit sad on a 
succession of grey, overcast days. Translating 
these emotions into your photographs takes 
more than just simply recognizing objects 
or estimating the time of day. Whatever the 
subject, it is the light that determinates the 
impact that a photograph has. The type of 
illumination captured in an image strongly 
influences its mood, feeling, and emotional 

quality as well as giving life and meaning to 
the subject captured. 

So before you start creating your 
photographs, you may wish to ask yourself: 
What is the direction of the light? Is it direct 
light or is it diffused light? What colour is 
it? Are there any shadows, and if so, do 
they have a hard or soft edge? Is the light 
pleasing to the eye? If yes, why? Once your 
eyes have been opened, you will discover a 
whole new dimension in your photographic 
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compositions. With time and 
experience you will focus and react 
to the light you perceive. 

Spend a significant amount of 
time experiencing light. This is what 
separates the great photographers 
from the good photographers. Be 
reflective and really learn to see 
the subtle characteristics of light 
sources. Observe, sense, and feel the 
presence of light and appreciate its 
nuances and variety.  Give yourself a 
photo project, and make “light” your 
main source of inspiration. It is our 
role as photographers to capture 
those special moments, using the 
best possible light.

This article and images contained are Copyright © and courtesy of Eva Polak. Please contact the author directly with any questions.

Creative exercise:

You can learn a lot about photography by visiting 
the same location several times, in several 
different lighting conditions. 

Try shooting the same scene (or subject) at 
different times of day, during different weather 
conditions, and even during the different 
seasons throughout the year. 

Make a point to try this exercise. You will see 
the dramatic impact these different lighting 
conditions have on the photos you take.
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by Heather Bashow

back to BAsics

in the past, owning a large assortment of 
filters was an essential part of maintaining a 
professional photography kit.  In fact, many 

photographers still prefer to do it all within the 
camera.  However, the advent of new DSLR 
cameras along with sophisticated software 
has resulted in many filters becoming near 
obsolete.  Software can correct many issues 
that made filters previously indispensable.  
Colour correction filters, sepia or black and 
white filters, warming and cooling filters, filters 
that soften – these are only a consideration if 
you do not wish to use a computer to correct 

your photos.  Even in places where neutral 
density filters were a necessity, Photoshop 
and Lightroom can do the correcting in 
most cases. There are purists who insist that 
software is cheating; yet film darkrooms 
were always used to dodge and burn, and 
otherwise manipulate photos.  Is a filter any 
less of a cheat than software?  That’s for each 
photographer to decide.

There are those who avoid filters, and 
those who embrace them. One common 
belief is that if you spend several thousand 

or Not to Filter?
to Filter,
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dollars on a lens, why would you slap a 
lesser quality piece of glass in front of it all?  
Others feel that it is a good idea to protect 
that investment from scratches with at least 
a simple clear or UV filter.  I suggest that if 
you do use a filter, buy the best.  Since any 
filter can potentially reduce the quality of 
the image, filters should only be used when 
necessary. 

Let’s take a brief look at some of the 
most common filters for digital SLRs, along 
with their intended uses, advantages, and 
disadvantages.

UV Filter
The simplest and least expensive of filters, 

ultraviolet (UV) filters supposedly reduce haze, 
but it is pretty difficult to tell if they actually do 
this. They do however protect the front of your 
lens.  If you are shooting without a lens-hood, 
or just want an extra layer of protection, a UV 
filter will do the job.

Polarizing Filter
One of the few filters that are still a 

necessity (even for DSLRs), a polarizing filter 
reduces glare.  It also improves saturation, but 
that part can be done with software.  When 
used during water or glass photography, 
a polarizing filter will allow the camera to 
show detail that is usually obscured by the 
glare of reflected light.  It will also reduce the 
reflected light on leaves and grass, and will 
deepen the color of the sky and leaves.  

Keep in mind that dark polarizing filters 
should only be used when necessary since 
they reduce the light to your camera’s 
sensor by 2 or 3 stops. This will affect action 
shots since less light through the aperture 
will mean that your shutter speed must be 
slower, unless you are cranking up the ISO 
to compensate.  Polarizers can also cause 
vignetting. 

There are circular and linear polarizers.  
DLSRs use a polarizing half mirror system 
that can cause metering problems if you 
use a linear polarizer. Therefore, circular 
polarizers are recommended for most 
digital SLR cameras.  These polarizers will be 
marked with a CIR-PL or C-P-L to indicate 
they are circular.

Polarizing filters help to deepen skies and boost saturation. The first image (left) was shot with no filter which resulted in a slightly washed out image. The second image (right) was 
shot with a circular polarizer. Look at the dramatic difference in colour saturation - all without any post-processing!
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Neutral Density

As long as it isn’t so bright that you cannot 
capture the detail in the highlighted areas, 
neutral density filters can be avoided.  One 
method is to bracket your shots, essentially 
having three or more different exposures of 
the same photos.  Then you can mask the 
best areas of each photo, and blend them 
together into one shot, thereby having a 
perfectly exposed photo in both the light 
and dark areas. This obviously requires a time 
investment in post processing.

Alternatively, if your photo already has 
detail in both the dark and light areas, but 
you just want to darken a lighter area, you can 
apply a neutral density gradient filter to the 
shot in Photoshop.

However, it is possible that in certain 
conditions the camera will not capture a 
good photo if it is too bright.  Your best 
option in this case is a Neutral Density filter. 
An ND filter does one thing – it reduces 
the amount of light entering your camera, 
allowing you to shoot bright things in 

ND filters reduce the amount of light entering your camera. This allows you to shoot with slower shutter speeds, even in bright light. The first image (left) was shot with no filter on 
the lens. The slowest usable shutter speed was 1/45 at f/22, and it’s still blown out. The second image (right) had an ND filter and was shot at 1 sec at f/22, nicely blurring the water.
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bright light.  For example, you might want 
to photograph a waterfall at mid-day, while 
slowing the shutter speed to blur the water.  
You might find that even with the narrowest 
aperture and lowest ISO, there is still too 
much light for the camera to take the photo.  
Or you might want to use a wider aperture 
for a more aesthetic background, but too 
much light is a problem. ND filters are dark 
enough to block some of the light hitting 
the sensor, allowing you to use those slower 
shutter speeds in bright light.  Neutral 
density filters come in different levels 
of darkness, and are a uniform darkness 
throughout.

graduated Neutral Density
Used most often for landscape 

photography, the GND filters work differently 
from the ND filters. A GND filter restricts 
the light in a smooth geometric pattern, so 
is effective in shots where there is a linear 
blend from light to dark, such as in a sunset 
where the sky may be much lighter than 
the foreground. Typically part of the filter is 
dark (essentially an ND filter), and the other 
half is clear. They can help prevent highlight 
blowout in the brighter areas, without 
darkening the shadow areas of a scene.

Filter Sizes

The diameter of your lens is a governing 
factor when you purchase a filter.  The 
diameter is indicated by a ø symbol or mm 
number on the lens, for example, ø49 or 
36mm would indicate that the diameter 
is 49 mm, or 36 mm. If you have lenses of 
several different diameters, you might want 
to consider an adapter ring that bridges the 
size between your larger filter and the smaller 
lens diameter. Adapter rings can be stacked if 
necessary to cover all sizes of filters and lens 
diameters, thus allowing you to get by with 
fewer filters for all your lenses.

the Bottom Line...
One of the great things about DSLRs 

and software is that it has made filter use 
unnecessary in many cases.  Of course, there 
are still times when filters can help you 
capture something that isn’t possible without 
them, but it’s also important to remember that 
any glass between your lens and the subject 
will likely not be as precision-worked as your 
lens glass.  If you bare in mind the positive 
and negative effects and use them only when 
required, filters can be a valuable addition to 
your camera bag.

Graduated Neutral Density filters have a graduated fade from dark to light (which can be positioned by sliding the filter up and down the mount), allowing you to darken only the 
bright areas of your scene. As a result, we can darken the blown out sky while keeping the correct exposure on the foreground land. 

This article is Copyright © and courtesy of Heather Bashow. Please contact the author directly with any questions.
Images are Copyright © and courtesy of Dave Seeram.
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last month, we started the first 
in a series of articles on “Telling 
a Story” with your photography.  

We discussed the differences 
between taking vs. making a photo, 
and what is involved in each.  
Both tell particular stories and are 
unique to specific genres of the 
more general field of photography.  
Naturally, your chosen photo genre 
will help define and shape the story 
for you, but it helps to identify what 
story you are going to tell before you 
begin to take or make photos.  So 
having set the stage for taking and 
making photos, we can now focus 
our attention on the type of story 
we are going to tell, and today, we’ll 
delve more deeply into the taking 
and making of the portrait story.

It should be no surprise that 
the idea of making photos from 
an internal creative idea usually is 
much more complex than that of 
a photojournalist.  They have to be, 

by Jason Anderson

 telling a
photo story

tips & Techniques

Making a Portrait Story
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since you are almost always taking more than 
one photo.  Even in cases where it’s a photo of 
one scene, post-processing brings out aspects 
and elements of that scene that simply 
cannot be done straight out of the camera (for 
instance: time lapse photography, HDR pieces 
and photo montages all require a certain 
degree of post production).

When the story is one of your own inner 
visions, photographers will often work alone, 
taking photos, assembling, and blending them 
in various ways during post-processing until 
the internal vision comes to life.  It is under 
this premise that the phrase “pixels are born to 
be punished” comes to life.  The “journalistic” 
aspect of photography is left in the dust here, 
so have no fear.  Edit to your hearts content 
until your own personal vision is revealed.

The true challenge of telling a photo 
story arises when you are making photos 
of other people.  This is where the portrait 
photographer comes to life. They have 
a vision of their subject that translates 
through their photos, which both satisfies 
an internal voice and makes the subject 
of the photo look amazing.  A big part of 
telling that story is the ability to capture 
the essence of the subject into the photo.  
It’s their personality, emotion, or the story 
of their own lives that needs to come 
through.  This can be extremely challenging, 
especially when people often act differently 
in front of a camera than how they normally 
act.  The question then becomes one of how 
to get people comfortable at revealing their 
own story in front of your lens.  There are a 
couple ways to do this.
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The first, and perhaps the easiest way, 
is through the use of props.  People often 
feel awkward at how to place or position 
themselves within the portrait space.  This 
can be addressed through props.  It could 
something as simple as a glass filled with 
water, wine, or any other beverage.  Other 
fun props that I’ve used include fire hoses, 
cowboy hats, guitars, and fishing rods.  Even 
cameras can be used as that gives people 
something to latch on to as a means for 
expressing themselves (How many of you 
have taken shots of other photographers in 
duels?).  Take a look at the smile behind the 
lens of the other gal or guy – it’s usually quite 
an original expression!

Another way to get genuine expressions 
out of the person you are photographing is to 
have them actually do something.  Let them 
get crazy or silly if they want.  If you are taking 
photos of a dancer, have him or her do that 
tippy-toe thing.  I was on a photo shoot myself 
a while back taking photos of the Arvada Dance 
Company and the girls loved the opportunity 
to really ham things up.  They jumped and 
twirled, and even made some silly Halloween 
faces for the camera, giving me the chance to 
make some great photos of them in action, 
really showcasing their personality.

It should come as no surprise that 
you can also bring out the personality of 
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someone through your lighting.  A soft 
light on someone in a profile position 
can be quite dramatic.  The same holds 
true for the peaceful glow of candlelight, 
firelight, and of course, the horizontally 
angled lighting of sunset and sunrise 
scenes.  (Side note: I tend to prefer 
sunsets for portrait work, as many people 
are not at their best that early in the 
morning - myself included!)  Remember 
to show them what the shots look like 
on your camera’s LCD.  By seeing what is 
happening in-camera, people become 
much more comfortable that you are 
taking and making some great photos.

The absolute best way to take and make 
powerful portrait photos is to take the time 
and get to know your subjects.  Unless it’s 
a professional model, most people don’t 
warm up to the camera – they warm up 
to the photographer.  That only happens 
when you take the time and talk with them.  
It can be challenging to even do this.  In this 
crazy world, we are so driven to go out and 
get things done in a nanosecond, not wanting 
to waste any more time than we have to from 
everyone’s busy schedules.  

Many photographers will let their 
subjects know that they will need at least an 
hour with them for their photo session.  That 
becomes a good time investment to actually 
sit down and talk with your subjects.  Find 
out their interests, their hobbies, and what 
they are passionate about.  More often than 
not, they have some props in their own 
repertoire that speak to those hobbies and 
interests.  Perhaps they even have similar 
interests.  If the planets align (and they often 
do), the photographer and the subject wind 
up becoming connected in the process.

In knowing the subject, it is often a lot 
easier to elicit a laugh, that unique smile, or 
that spark in the eye that they only show to 
those they are connected to on some level.  
It really makes the process of photographing 
people easier when you connect with 
them.  Whether it’s family, friends, or new 
subjects, they know you will only print and 
make photos that show them at their best 
because they will have that established 
trust in you.  In order to take and make truly 
compelling photos, that trust has to be 
there.  Otherwise, it’s likely going to end up 
in the recycle bin or on a disk somewhere 
relegated as a snapshot that never gets 
viewed, nor shared, and never displayed.  

Make your photos tell a story and not only 
will more people see them, you’ll have more 
passion and satisfaction from your work.  It’s 
worth the effort!

This article and photos contained are Copyright © and courtesy of Jason Anderson. Please contact the author directly with any questions.
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flickr is the world’s largest photo-sharing 
site with almost 4 billion photos and 5.5 
million members. Let me reiterate - Flickr 

is a photo-sharing site, not a stock photo or 
art-print sales site like Red Bubble or Fine 
Art America.  However, just because Flickr is 
a photo-sharing site, that doesn’t mean you 
cannot generate sales.  You can (just as I have), 
but you have to understand how to play the 
game. I recently read an article about making 
money on Flickr and one of the comments 
was, “Just how can you expect to make money 
on a photo sharing site where people can 
just download and use what ever they like for 
free?”  Let’s find out.

Flickr offers several types of copyright 
licenses.  Some recommend Attribution 
Creative Commons, which allows anyone 
to use your work for non-profit while you 
retain all rights to it.  I prefer to use the “None” 
option so that I retain all rights to my images.  
This way if my work is desired, instead of just 
taking it, a potential buyer can contact me 
and inquire.  Personally, I like to know where 
my work is being used.

 Before you can sell anything, people have 
to know it exists and this is where Flickr has 
strength.  It is almost like advertising your 
product, or like having your own private 
online art gallery that is open to the world.  
I think that many people misunderstand 
what photo sharing actually is.  They think 
anybody can download and use your work 
for free.  This is only true if you allow it.  In 
addition to the image rights settings, there are 
privacy settings worth spending some time to 
understand.  Of course, anytime you upload 
photos on the Internet, you risk the photos 
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being copied and used.  However, I generally 
post resized low-res photos that are more or 
less useless, except maybe for web use. I also 
retain all rights to my photos and only allow 
Flickr members to download my photos.  I 
generally share my work when I am asked 
because sometimes it can be beneficial to me.  

For example, I was recently contacted 
by the co-publisher of the UNESCO “World 
Heritage” Magazine, who was interested in 
using two of my images that I have posted in 
my Flickr account. They were requesting the 
images for free, and if I could send them high-
resolution versions of the files. What would 
you do in this case?

Well, even though this publication was 
interested in using two of my photos for free 
(and possibility for a cover shot), I had to take 
into consideration that this is a UN publication 
and would be seen by several important 
people.  I would be a fool not to agree to let 
them use my photos if they choose to.  Yes, 
there was no offer of compensation, but this 
could very well open a few doors for me.  This 
is an important consideration, and at the very 
least, it shows just how well your work can get 
noticed on Flickr.

I have had indirect sales of my images 
from Flickr. My image-based art sales include 
photos for airline magazines, travel and 
tour guides, calendars and post cards, and 
even a photo for a British English Grammar 
textbook called “The Big Picture.”  These 
sales are possible because the sheer amount 
of photos and image-based art on Flickr 
draws publishers, graphic design directors, 
magazines, newspapers and ad agencies 
looking for work to use.  It costs serious 
money to hire and send a professional 

photographer half way around the world, so 
buying images from photographers on Flickr 
saves these publishers a significant amount 
of time and money.  

Publishers are usually more than willing 
to pay an artist for the use of their work.  As a 
matter of fact, Getty Images, the world’s largest 
stock photography company has teamed up 
with Flickr.  Getty Images has a staff that reviews 
postings made on Flickr, and then when they 
find something they like, they invite the Flickr 
member to join Getty Images. I personally 
prefer to deal with the client myself and cut out 
the middleman.  This is a personal decision you 
would have to make for your own work.

Selling on Flickr is not allowed, officially.  
However, there are ways around this while 
still playing by the rules. Firstly, I strongly 
recommend upgrading to a Flickr Pro account 
because there will be no limits on your 
uploads.  Free accounts limit your uploads to 
200 images.  The more images you are able to 
upload, the more choices potential buyers will 
have.  A Flickr Pro account is pretty affordable 
at approximately $25/yr, or a tad less if you buy 
a two-year Pro account.  

When somebody is interested in using 
or buying one of my images, they will either 
send me a personal message through 
Flickr mail or email me to discuss the 
terms. Flickr only allows links to personal 

Flickr Pro provides you with daily stats on the views of your images.
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photo webpages to be placed in photo 
descriptions.  Linking to stock photo sites 
or image-based art purchasing sites is not 
allowed in the image description. However, 
you can through personal messages and 
emails.  For those who wish to purchase 
a single print of one of my Flickr images, 
I provide a link to my Red Bubble gallery 
through our correspondence and they 
can purchase prints from there.  So if you 
are serious about selling, you will need an 
alternative setup where people can buy 
prints.  Red Bubble is completely free and is 
the site I use for people to buy my prints.
(http://www.redbubble.com/people/bossman) 

Keywords and tags
Using the right keywords and tags are 

important for people to find your images.  
The Flickr search engine uses these tags 
and keywords to conduct searches, which 
is necessary when you have over 4 billion 
images to deal with. Therefore, it’s important 
to be smart when tagging and adding 
keywords for each image. For example, the 
last photo I sold on Flickr was an image of a 
Moscow policeman making a driver wash 

his car.  If you search Flickr for “Moscow 
Police”, you get over 3100 results.  Editors and 
publishers do not have time to sort through 
every photo and this is where tagging your 
images appropriately can help yours to be 
found. I only used 5 keywords or tag words: 
Moscow, Russia, Militia Officers, Road Police, 
and Clean That Dirty Car (multi word tags can 
be used).  That led the photo editor directly 
to what she was looking for.  

Flickr groups
Post your work to groups. On Flickr, there 

are photos covering just about every subject 
there is to photograph.  In turn, there are just 
about as many topic-specific groups on Flickr. 
Placing your work in specialized groups will 
help those interested in that subject matter 
to find them. Another benefit of placing your 
work in groups is that you can dialogue or 
share advice with other photographers and 
artists who share your similar interest. You can 
even create your own groups and invite other 
like-minded photographers or digital artists to 
post their work to the group. 

Photo Sets
Create sets for your photos.  Your Flickr 

gallery is referred to as your “photo stream”, 
and organizing your photos into sets will help 
viewers find your images more easily once 
they land on your photo stream.  Think of 
sets like “folders” – another means of further 
organizing your photos. Also, try to name 
your sets appropriately based on the types 
of images you put into them.  It helps with 
the ease of navigating your photo stream, 
and can increase the time that viewers spend 
checking out your photos. 

http://www.redbubble.com/people/bossman
http://www.flickr.com/photos/jonayres/4036535817/
http://www.flickr.com/photos/jonayres/4036535817/
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explore Home
Explore is Flickr’s Daily Artist Showcase. 

Everyday, the Flickr administration chooses 
500 of the most interesting images to 
showcase.  Being chosen as one of these 
special few can mean a huge increase in 
views of your photo stream along with the 
number of comments and favorites you 
receive. Ending up on the front page of 
Explore will give a significant boost to the 
traffic on your exposure, not to mention 
building up your ego a little!

Sell Yourself!
Do not be afraid to approach an editor 

about using your work.  When it comes to 
publicity, it’s not just a one-way street. We 
would all love to be sought after by editors, 
but sometimes you need to approach them. 
Follow publication blogs and websites on 

Twitter and Facebook to get the latest news 
about upcoming issues. Be willing to drop 
them an email with a great idea for a blog 
post along with some samples of your photos, 
and a link to your Flickr album.  Take interest 
in them and they may take interest in you.  In 
fact, this is how many guest submissions to 
PhotographyBB are made! Often in today’s 
world, we have to sell ourselves first.

Flickr is the perfect platform to show off 
your images to the world.  If you are new 
to Flickr, give their free account option a 
try.  If you are interested in making sales, 
then go with Flickr Pro.  For the reasonable 
cost, you can more than make up it with the 
sales and potential long-term professional 
relationships you can make.  If you would 
like to learn more, or just say hi, feel free to 
drop by my Flickr page sometime at:
http://www.flickr.com/photos/jonayres

A snapshot of how viewers find your images. This info can be important in helping you to decide on what photos to take based on where your traffic comes from.

This article and images contained are Copyright © and courtesy of Jon D. Ayres. Please contact the author directly with any questions.

http://www.flickr.com/photos/jonayres 
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modern advancements in digital camera technology 
keeps evolving, offering advancements such as 
increased ISO shooting capabilities, noise reduction, 

better colour reproduction, etc...  So why on Earth would 
we want to grunge up our beautiful photos? Because we 
can! In all seriousness, there are certain artistic and creative 
benefits in giving our images an old-time aesthetic. 

Step 1
We’ll begin with this photo of me enjoying my beverage 
of choice - Darjeeling Tea. By adding an old style grunge 
effect, we can vastly improve the artistic style of this 
image (no improvements on image content of course!)
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  how to “GruNGe up” your Photos in PhotoshoP
by Dave Seeram
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Step 2
We’ll begin by preparing our background image layer for Smart 
Filters. Go to the menu: Filter > Convert for Smart Filters. 
 
If a dialog box appears, simply click OK to accept and continue.

Step 3
Next, we will add a Black & White adjustment layer. Every image 
will be slightly different, so play with the different sliders until 
you find the tonal balance that works best for your photo.

Later, we’ll come back to this filter (since it is now a Smart Filter), 
to add an colour tint once we can see the finished grunge effect.

Step 4
Old images often appear faded and washed out. Add a 
Brightness/Contrast adjustment layer. Here you can increase the 
brightness, and decrease contrast. Again, each image is going to 
require different settings, so experiment until you find settings 
that you like best for your photo.

Step 5
Here’s where we are at so far after performing the above 
adjustments.

At this point, if you feel that you would like to make further 
adjustments to the tones, brightness, or contrast of your black 
& white image, you can simply double-click on any of the 
adjustment layers to make changes.

Once your black & white image is ready, we can move on to the 
grunge effects.
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Step 6
Old photos often have faded, random spotting. We can simulate 
this in Photoshop with the Clouds Filter.

Press “D” to reset your colour swatches to their defaults. Then 
create a new layer and go to the menu: Filter > Render > Clouds
Click OK to apply the filter.

Step 7
We need to reduce the intensity of the clouds layer in order for it 
to produce more realistic faded spotting in our photo. To do this, 
go to the menu: Image > Adjustments > Levels...

When the Levels dialog box appears, move the middle slider 
(under the histogram) to the right, to reduce some of the bright 
clouds. Click OK to apply the Levels adjustment. 

Step 8
To apply the faded spots to your photo, change the blend mode 
of your clouds layer to Color Dodge, and reduce the opacity to 
around 25%.

If you end up with spots in areas that you do not want them 
(such as on a person’s face), you can use a layer mask to mask 
them out. Alternatively, you can simply use the eraser tool on 
the clouds layer to erase areas of the spots. 

Here’s what the image looks like at this point.

Step 9
No old photo would be complete without the wear and tear 
effect of scratches and/or cracks. If you have a texture, place it 
using the menu: File > Place... Stretch it using the resize handles, 
so that it covers your image completely. Click enter to apply.
 
As we learned in Volume 50 and 51 of PhotographyBB Magazine, 
applying a texture to an image can have a dramatic effect and 
artistic appeal. Please refer to those editions for further details on 
how to apply textures.
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Step 10
To apply the texture, you can choose a variety of blend 
modes on the texture layer. Here we used Overlay, but 
sometimes Soft Light, Hard Light, Vivid Light, and Pin 
Light also work very well. Experimentation is the key, so 
try all of them to see which works best for you. Once you 
find the blend mode that you like, reduce the opacity to 
best suit your photo.

We’re finished! But let’s take it a step 
further. Double click on your Black & 
White adjustment layer, and check the 
“Tint” box. Next, choose any subtle colour. 
Blues and Oranges work very well.

Step 11
There are a few final improvements 
we can make to the image. All 
of which are optional, but highly 
effective additions.

Click on your Background layer to 
make it active in the layers palette.

Option 1: Add noise
Menu: Filter > Noise > Add Noise...
Choose Gaussian, and check the 
monochromatic checkbox. Click OK!

Option 2: Add vignette
Menu: Filter > Lens Correction...
Under the Custom tab, you can 
add a vignette to your image. This 
darkening of the corners can have a 
beautiful effect on the final image.

Have fun experimenting with these 
techniques. After all, it’s cheaper 
than going back to film, and faster 
than waiting for your photos to age 
naturally. Happy Photoshopping!

This article is and images contained are Copyright © and courtesy of Dave Seeram. Please contact the author directly with any questions. 
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PhotograPhyBB ForuMs Photo assignMents
Photo assignMent: “spin that Coin!”

This time around, we challenged our members not only with their photographic and 
creative abilities, but also with their coin-spinning prowess! This theme proved to be 
difficult, but the results are beautiful. Here are the top selections for this theme:

top: Photo by “ezigman”. Bottom-left: Photo by “Debrasue”. Bottom-right: Photo by “antoniorivero”. 
thanks to all participats. We look forward to all of your submissions in our upcoming challenges!
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Do You Have a 
great Idea for 
a Photography 

article?

We are looking for talented 
individuals who would like 
to expand their portfolios by 
volunteering to contribute 
articles to this e-magazine! 
If you are interested, we’d 
love to hear from you.
topics of interest are:
- Photography Techniques 
- Photography on Location 
- Photoshop Tutorials 
- Hardware / Software Reviews 
- Camera Equipment 
- Member Spotlight 
- Plus we’re open to new ideas!

To become either a regular contributing 
author, or even just for a one-time article, 
please email us at:  

magazine@photographybb.com

Introduce yourself, share your idea, 
and maybe we’ll see you in next 
month’s issue!

Step into the Spotlight!
Would you like to be featured in the 
PhotographyBB online spotlight on Member 
section? if so, please let us know at: 
magazine@photographybb.com

We’ll feature your photos, a small biography and 
write-up about you, as well as links to your web 
gallery or photography related business. We all 
love photography and image editing, so let’s get to 
know each other!

been Around the World?
We are looking for talented writers who would like 
to share their experiences in visiting far away places, 
or even your home town for that matter. in our 
Photography around the World column, we take our 
readers on a photographic journey, and we would 
like you to be our tour guide.

if you would like to share your story and 
photography of a city you have visited, please 
contact us and share your idea with our team. We’d 
love to hear from you!

Discounts for readers:
For those of you who are interested in getting into 
hDr photography, there simply is no better hDr 
software then hDrsoft’s Photomatix Pro, available 
as a stand alone software and as a Photoshop 
Plugin. Visit:
http://www.photographybb.com/hdr/
and use the coupon code: photographybb.com 
for a special discount. also, check out the shop 
PhotographyBB site for links to some great deals on 
cameras and accessories. Best deals on the web!

thank you for reading the PhotographyBB online 
Magazine. We hope  you enjoyed it, and we’d 
love to see you again next month. if you have 
any questions or comments for us regarding 
this magazine, please feel free to email us at: 
magazine@photographybb.com

mailto:magazine@photographybb.com 
http://www.photographybb.com/hdr/ 
mailto:magazine@photographybb.com

